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All rights reserved

Manual

This document is provided “AS IS”. FastVDO LLC does not make warranty of any kind expressed or implied, including but
not limited to, the implied warranties of merchantability and fitness for a particular purpose. Information in this document is
provided solely to end users to use FastVDO’s SmartCapture. FastVDO does not warrant that the contents of this
publication, whether individually or as one or more groups, meets your requirements or that the publication is error-free.
This publication could include technical inaccuracies to typographical errors. Changes may be made to the information
herein, and these changes may be incorporated in new editions of this publication without any notice

This manual is organized by function & Operations of the SmartCapture device & is presented in order of probable use,
but feel free to review the information in whatever manner you desire - even skip sections if the content is familiar. No part
of this documentation may be reproduced or transmitted in any form or by any means, electronic or mechanical, including
photocopying, recording, or information storage and retrieval systems, for any purpose other than personal use, without
the permission of FastVDO LLC. FastVDO LLC may update, change or remove parts of or the entire manual without
warning or notice. Updated versions of the manual maybe obtained from FastVDO LLC, if there is valid proof of purchase
of the product & upon request by the user.

SmartCapture Package

SmartCapture package is provided "as is" and any express or implied warranties, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose are disclaimed. in no event shall FastVDO LLC be liable
for any direct, indirect, incidental, special, exemplary, or consequential damages (including, but not limited to,
procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however caused and on
any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of
the use of the contents of the SmartCapture package, even if advised of the possibility of such damage.

Trademarks

Many of the designations used by manufacturers and sellers to distinguish their products are claimed as trademarks.
Where those designations appear in this documentation, FastVDO LLC was aware of a trademark claim, the designations
have been printed with the ® symbol beside the trademark.

IPod®, IPod® trademarks, QuickTime® & QuickTime® trademarks are the property of Apple Inc.
Sony PSP® & Sony ® trademarks are the property of Sony Inc.
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Package Contents

- =FugVDO

like it's meant o be...

e SmartCapture Device
e CD ROM (Containing Drivers, SmartPlayer and Manuals)
e RCA male cable

If any of the above mentioned contents are missing, please email us at support@fastvdo.com .

System Requirements

Windows XP (Service Pack 2)

Pentium 4 or higher

256 MB RAM or higher

High speed USB port (USB 2.0 recommended)
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Introduction

Congratulations on choosing SmartCapture for your video capture and encoding needs.
SmartCapture is the world’s smallest USB based Audio/Video capture and encoding device. It
supports real-time, high quality Audio Video capture and compresses using the latest H.264/AVC
video standard and AAC audio standard. Captured and compressed video/audio streams are
delivered to PC through simple USB interface for storage. Content creation, content repurposing,
field acquisition, surveillance, news gathering, and a host of applications are now available in a
compact, cost-effective form. A user friendly SmartPlayer software provided can be used to
capture and store encoded video from SmartCapture. SmartPlayer can also play back the media

files encoded by SmartCapture and other media formats.

Features

USB-powered, no external power source required.

Low-power

Low cost

Light weight and compact form factor

Real time audio/video coding

Video encoding using the latest H.264 compression standard.

Audio encoding using the AAC compression standard.

Minimal processor usage as Capture and encoding done on the USB device.
Configurable Bitrate range: 32 kb/s up to 4 Mb/s

Configurable frame resolution (resize) : 160x120 up to 720x504
Configurable frame rate.

Supports full D1 resolution NTSC/PAL analog Input.

Two channel Audio (stereo L/R).

Encoded file formats: H.264 video and AAC audio, in MP4 file format
Encoded files compatible to play on QuickTime®, Apple iPod® and Sony PSP®.
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Installing SmartCapture Device drivers

Insert the CD into your CD-ROM drive to launch the FastVDO SmartCapture installer.
(If auto run is disabled, please browse to the CD-ROM drive and double click on setup.exe)

FastV¥DO SmartCapture Installer EHE E|

Install driver before plugging
inthe SmanCapture Device i

Install SmanFlayer SmanFlayer
Installation Guide

Exit

Click on Install Device Driver button and follow the installation wizard.
NOTE: Please install device drivers before plugging in the device

Software Installation

L] E The saoftware you are inztaling has not pagzed Windows Logo
- testing o vernify its compatibility with *windows =P, [Tell me why
thiz besting iz important. |

Continuing your installation of thiz software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microzoft strongly
recommends that you stop this installation now and
contact the software vendor for zoftware that has
pazsed Windows Logo testing.

LContinue Anyway ] EéTDF'InstallatiDn |

When prompted with the above dialog box, click Continue Anyway.
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SmartCapture Device Driver Installation

The Drivers have been successfully
installed on your System.

The drivers were successfully installed on this computer.

Tou can how connect vour device to this computer. [F pour device
came with inztructions, please read them first.

Diriver Mame Stalg
s FastyD0 LLC [BULKUSB) USE (SmartCapture +1.00) Rea

Finizh l [ Cancel

Click Finish to complete the Driver installation and plug in the device.

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helps pou install zoftware for:

SmartCapture

.r\_') If your hardware came with an installation CD
= or Hloppy disk. insert it now.

What do you want the wizard to do?

(3)i|nstall the software automatically [Recommendsd§
() Install fram a list ar zpecific location [Advanced)

Click Mext to continue,

Mesit » l[ Cancel

After plugging the device in, windows will pop-up the Found New Hardware Wizard. Select “Install
the software automatically” option and click next.
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L] "-l., The saoftware you are installing for thiz hardware;
i ]

SmartCapture

haz not pazzed Windows Logo kesting to werify its compatibility
with YWindows =P, [Tell me why this testing iz imparkank. |

Continuing your installation of this zoftware may impair
or destabilize the correct operation of your spstem
either immediately or in the future. Microzoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for zoftware that has
paszed Windows Logo testing.

LContinue Angwal ] L_ﬁTEIF'InstallatiDn |

When prompted with the above dialog box, click Continue Anyway and complete the driver
installation.

Installing the SmartPlayer

Click the SmartPlayer button on the FastVDO SmartCapture installer and follow the wizard to
install the Player.

i SmartPlayer, - InstallShield Wizard
Welcome to the InstallShield Wizard for tx

ﬂ SmartPlayer
o~

i

The Installshieldif) Wizard will install SmartPlayer on your =
computer. To conkinue, click Mext,

=

< Back  Mextx | [ Cancel
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SmartCapture Setup

To capture and encode from any analog source like camera, DVD player or TV using the
SmartCapture, connect the RCA plugs of the cable (Yellow (video), Red and White) to “A/V-OUT”
of the source. Connect the 3.5mm jack of the cable to the “A/V-IN" of the SmartCapture. Plug the
SmartCapture device to the USB port of your computer or laptop.

NOTE: Install the drivers from the CD before plugging in the device.

f?\E_ %-rg

VHS

iPod

SmanCapure

Laptop or PC y

SmartCapture Setup
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SmartPlayer

File Tools Plav Help

[ SmartCaphure

Feady to open File or SmartCapture...

The SmartPlayer provides both recording and playback functionalities. The audio video data
being captured and encoded can be previewed or saved using the SmartPlayer. Following
multimedia formats are supported by SmartPlayer

Video: H.264

Audio: MP3, AAC
File formats: MPEG-2 TS (.mpg), MP4 (.mp4), QBox (.qbx) — proprietary file format

Recording from SmartCapture

Launch the Player. Check the SmartCapture check box to enable the SmartCapture device
options. These options can also be enabled through the menu bar (File>Read SmartCapture).

SmartPlayer, E|§|®

File Tools Plav Help

["-.fiew ” Feo ”Dptinns][ﬁettings]

25 Walume

[v SmartCapture

Feady to open File or SmartCapture...

View — Preview the video/audio data encoded by SmartCapture.

Rec — Recording/Saving the SmartCapture encoded data.

Options — Customize device & recorder settings.

Settings — Change Brightness & Color saturation on the video data encoded.
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Previewing from SmartCapture

Plug RCA cable into the audio/video source, plug the 3.5 mm jack into the SmartCapture A/V in.
Plug the device into an USB port on your PC.
Click the “View” button, to view the captured sequence.

SmartPlayer
Ele Tools Play Help

[ Stop ” Rec ] Optionz ’Settings]! i;
¥ SmanCapture  Audio: |[EHEEY voeo [EENEE

Previewing from SmartCapture

Recording/Saving the encoded data

Click the “Rec” button to start saving/recording the encoded sequence. SmartPlayer automatically
generates the file name when the Rec button is clicked, the file name given is based on the time
at which the Rec operation was started. For example if the recording was started on May 16"
2007 at 7:26:18 P.M. then the file name will be May1607-072618PM.mp4.
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NOTE: With default settings encoded file will be saved at the location C:\Temp. You may choose
to save the files at a different location through Options or Record settings (Tools> Record
Settings).

Stop Preview/Recording

Click the “Stop” button to stop preview/recording.

Brightness / Color settings

The brightness and color saturation settings maybe changed for the video being encoded or
previewed, by clicking on the settings button.

Brightness

Min J M

Calar

Min J Pl
|Defaut| | Close |

The brightness / color saturation may be varied while previewing or recording.

NOTE: The recorded video will have the brightness / color saturation settings as adjusted by the
user.

Full Screen and Volume Control

The sequence being previewed may be viewed in full screen mode by pressing Alt+Enter. To exit
from full screen, press Alt+Enter or Esc.

The Volume scroll bar increases or decreases the volume of the sequence being previewed. The
Volume Mute button will mute or un-mute the volume of the sequence being previewed.

NOTE: Controlling the Volume on the player does not control the volume of the recorded
sequence. The recorded sequence will have the same volume as of the source.
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Options and Settings

Click the “Options” button to change the Device Settings or Record Settings.

Device Settings

Device Settings | Fiecord Settings

Type of encoding | \ideo & Audia |+ |

Prezets

Computer

: iPod
Audio | 48 kb Internet
Viden |1 pjpps V02 mal

Bitrate contral

| ]
—

Yideo Caontralz

Width ¥ Height Frame rate
640 v | (480 v | [0« [FPS)
GOP size / frame interval
[ )4 l [ Cancel ] [ Rezet ]

Device settings can also be accessed from the menu bar (Tools—>Device settings).

. Type of encoding - This option allows the user to select the source type for encoding.
> Video only
> Audio only
» Both Video and Audio

o Presets — This option allows the user to select the presets for encoding a sequence for:
» Computer/Laptop
» iPod®
> Internet
> Video e-mail
The table below describes the default presets for each of the targets.

Target Resolution | Video bitrate | Audio bitrate | Frame rate
(Width x (Kbps) (Kbps) (fps)
Height)

Computer 640 x 420 1000 48 30

iPod® 320 x 240 512 48 30

Internet 320 x 240 256 32 30

Video e-mail 320 x 240 128 24 15
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. Bitrate control - The bit rates at which SmartCapture should encode the Audio/Video data
can be preset using this option.
» Audio Range — 48 kbps to 128 kbps
» Video Range — 32 kbps to 4 Mbps

o Video Controls— These options can be used to modify video resolution, frame rate and |

frame intervals in encoded video

> Width x Height — Resizes the output video to specified width and height.

» Frame Rate — Sets the number of frames that are encoded in one second. Default
value is 30 fps. Using lower frame rates is recommended for lower bit rates.

NOTE: At Lower frame rates, video output might not be smooth.

» | Frame Interval — Sets the refresh frame or intra-frame interval. | Frame at every 30
frames is recommended.

Record Settings

Device Settings

Set Directory to zave recorded files:

C:Mdump' g
Output File Farmat
MP4 [mpd]  w

Dizplay option

[ Display all frames while recording

[Mot recommended for higher bitrates
and computers with glower proceszorz)

[ 0K ] [ Apply ][ Cancel ]

Record settings tab maybe used to chose a different location to store the recorded files. The file
format drop down box allows the user to select MP4 or Qbox file format.
NOTE: These file formats may be played back using the SmartPlayer.

e .mp4 — multimedia format compatible for playing on IPod®

e .gbx —multimedia format with H.264 video and AAC audio.

Display Options check box maybe used to enable or disable displaying all frames while recording.
NOTE: Decoding H.264 Video requires lot of processing power, displaying all frames while
recording is not recommended at higher bitrates and computers with slower processors.
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Playback Options in SmartPlayer

SmartPlayer [El:@

File Tools Play Help

Play J| Stoe ﬂ‘ﬁ:lume

[ SmartCapture

Ready to open File or SmartCapture...

Opening a Recorded/Saved file

Click “Open” and browse the folder containing supported multimedia files. All supported file
formats will be shown. You can also select a desired file format, or choose “All files (*.*)” to view
all the files. Select the desired file and click open.

PIx
Lok ir: | [5) Teststreams v| (e s s S
LY h2645treams
\ 23 (Sdaac
ty Recent I5) IMPefStreams
Documents CImp3
— (mP4
F
L Eimpg
Desktop ,@qbox
u‘i’lSmartCapture
My Documents
My Computer
‘g File name: | hd | [ Open l
by Metwork. | Files of type: QB ax files [*.gbs) w [ Canecsl ]
OB ox files [*.qbx)

MP4 files [*.mpd)]
Al files 7]
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Player options
Click “Play” to play the selected file. Currently playing file maybe paused or stopped using the
respective buttons.

SmartPlayer

File Tools Play Help

.ﬂv:ld| 24d Dir | Rem | Rem Al | [ Repeat

£ 0 o

[~ SmartCapture
Flaying C:A\StreamssBad Day - Dariel Powter.mpd. ..

Play list

The play list window maybe used to create a play list of the encoded files for play back on the
SmartPlayer. The play list window can be shown / hidden by clicking the PL button.
(Tools > Show /Hide Playlist)

Always on Top
This feature maybe used to retain the SmartPlayer always on top of all the windows.

(Tools > Always on Top).

Using Help Option in the Player

Go to “Help” menu on the menu bar and select “Help” (Help—Help) to get help on the Device and
Player functionalities. This may also be accessed by pressing F1 on the keyboard.
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